
Welcome to ScriptWorx 3.0
ScriptWorx 3.0 is designed for web masters who want total code control, no matter what scripting 
language or file format they are using.    ScriptWorx 3.0 includes support for HTML 4.0, DHTML, 
JavaScript, VBScript, Cascading Style Sheets, Perl/CGI, ASP and SQL.    With samples to help get you 
started, you can produce fast and interactive pages in minutes.

New features in this release:
 Built in HTML Preview
 StyleBuilder for creating your own Cascading Style Sheets
 Revamped editor with support for bookmarks, gutters and enhanced syntax highlighting.
 Automatic Code Verfication - Blue: Correct / Red: Incorrect
 Click>Type allows you to click anywhere in a document and start typing.
 Support for ASP, SQL, Pascal and Perl (Including Syntax Highlighting).
 Support for tables, frames and Cascading Style Sheets.
 Open from Web allows you to download HTML files for editing.
 User-defined code lists for HTML and JavaScript functions.
 Enhanced editor with support for bookmarks.

Soft Lite ScriptWorx 3.0 is fully compatible with any browser, and now has a better installation routine for 
using your computer more effectively.    Best of all, you don’t need the latest computer to run it.

Registering at http://www.softlite.net/sworx/reg.htm gives you 90 days free technical support via e-mail, as
well as news on product updates and special offers.



Built-In HTML Preview
ScriptWorx 3.0 now includes its own HTML viewer, so you don’t need to have Microsoft(R) Internet 
Explorer™ installed.    Simply click the “HTML Preview” tag in the main ScriptWorx window and you are 
presented with a preview of the current page being edited.

This preview does not execute scripts or DHTML, the preview serves as a preview for how most web 
browsers will interpret your web page.    Click the “Browser Preview” button or pressing [F11] will launch 
your default browser with the page being edited.

There will be the option to use Internet Explorer’s preview in ScriptWorx in the next version, depending on
results of user comments.

Under the “HTML Preview” tab, there is an area to enter the address of a page you wish to view, and the 
arrow button next to it should be clicked to open the HTML file.



Style Builder
Using Style Builder: Click the “Style Builder” tab.

Style Builder allows you to quickly and easily create your own Cascading Style Sheets, and saves your 
work to a .css file.    The HTML required to include a style sheet is as follows:

<LINK REL="stylesheet" TITLE="Default" HREF="default.css" TYPE="text/css">

The “Choose Style Selector” option under the “Style Builder” tab selects which part of the document the 
styles will be applied to. P - Paragraph Body - Entire Document A - Hyperlinks.

Options in Style Builder: 

Fonts: These options allow you to control how text looks, from the size to the type of font being 
used.    To add this to the final style sheet, click the button with the tick mark on it.

Text: These options involve items such as line spacing, and wether or not hyperlinks are 
underlined or not.    

Box: Options under “Box” involve items such as an objects margins, or how much padding 
(spacing) there is between one object and another.

Positioning: Gives you pixel-level control options for objects on a page, and also the size and 
visibility of an object.

See Also:

Cascading Style Sheets



Cascading Style Sheets
Using Style Sheets: Creating a Style Sheet - Click the “Style Builder” tab.

Inserting a Style Sheet - External Style Sheet from Insert Menu.
Embedding - place data inside <style> </style> tags.

What Are They?

Cascading style sheets allow Web site authors more control over the appearance and presentation of 
their pages and extend the ability to precisely specify the location and appearance of elements on a page 
and create special effects. By defining style information in one location — the style sheet — an author can
then link the style sheet to all of the pages in a Web site to create a consistent, uniform appearance 
across the entire site. Cascading style sheets are an evolving standard being developed by the World 
Wide Web Consortium (commonly called the "W3C") for the next generation of Web browsers.

What Do They Look Like?

Style Sheets have identifiers for each group of styles: P(aragraph) A(href / link) H1(Header 1) and so on.   
The following would be an example for the style sheet of a paragraph:

P { font-size: x-large; color: green}

If you want to create a general style sheet, then use . followed by a unique name, for example:

.antiLine { text-decoration: none}

Which would ensure that hyperlinks in your page would not be underlined.    To use the style sheet, use:

class=”antiLine()”

inside the current HTML tag.

Style sheets can be inside the page itself, or stored in an external file with a .css extension.



Forms
Using Forms: To Add a Form: Click Add a Form from Forms Menu - [Shift] + [Ctrl] + [F1]

<form action=”“> Can be used to send forms contents via e-mail, or use a CGI script
To receive form data - <form method=”post”>
To send data to form - <form method=”get”>

What are Forms?

A form is a collection of form fields on a page and a form handler, which is a method of collecting 
information from the form. Forms are a key to making your    web page interactive. Users can "talk back" 
to your by filling in forms on your web site and submitting them. The layout of a form can include form 
fields, text in all paragraph styles, tables, images, and most other objects that can be inserted on a page.

A user fills in a form by typing into text fields, clicking radio buttons and check boxes, and selecting 
options from drop-down menus. The user then submits the form by clicking a button, usually labeled 
"Submit."    For an example, open the file “Formsubmit.htm” under the Templates tab.    You can also 
configure a form to send its data to your e-mail address.

Types of Form Field

Input Button (Submit / Reset):
Submit types (input type=”submit”) allows the form to perform its intended action, such as e-mailing its 
contents to you.
Reset types (input type=”reset”) allows all the fields in the form to be reset.

Check Box:
Specifies that an option is enabled, without affecting other options on the form.

Radio Button:
Used in groups, allows one option out of many to be selected.

Drop-Down Listbox:
Gives a list of options that a user can use.

Text Boxes (One Line / Scrolling):
Allows the user to enter text into the form.



Tables
Using Tables: Use the “Add to..” button in the “Instant Table” palette in the main window.

Tables are made up of rows and columns of cells that can contain anything you might put on a page, such
as text, images, forms, ActiveX controls, or Flash animations.    You can use tables to arrange data 
systematically or to organize the layout of a page. A table allows you to display text in side-by-side 
paragraphs or arrange text next to graphics. Use a table to simulate columns of text, or use a fixed-pixel-
width column to provide a margin for text on a page.



Scripting
JavaScript & VBScript

Using Scripts: Choose “Script” from the Insert menu - [Ctrl] + [Q]
Choose the “From File” option to use an external “JavaScript” file.
Choose “As Below” option to type in the script yourself.

What are Scripts?

Usually scripts are run by a Web browser when a page opens, typically to display information produced 
by the script. You can add VBScript (Microsoft Visual Basic Scripting Edition) or JavaScript to your page 
using the methods outlined above.    Scripts perform instructions one step at a time in a web browser, and 
can be used in conjunction with style sheets.

What does the code look like?

This a very generalised code layout for scripts which run on a web browser, not on the web server:

<SCRIPT LANGUAGE=”XScript”>
<!-- do.something(now);
//-->
</SCRIPT>

For any browsers that support neither JavaScript or VBScript, the use of:

<noscript> </noscript> gives you the opportunity to supply alternative information.

Functions

Functions are procedures carried out on an object, or for setting up an object (ie. The document, the 
window, the style) and are listed under the “Functions” tab in ScriptWorx.    Functions implement objects.

Events

Events do not perform a specific function, events are triggered by user activity, such as mouse movement
or the pressing of a key.

IMPORTANT NOTES:

VBScript will not work under Netscape Navigator / Communicator.

JavaScript and Java are two separate languages, and the only thing they have in common is the name.    
Java is a trademark of Sun Microsystems.    Java is used mainly in graphics on web pages, but does have
other uses.



Using Java
Using Java Applets: Choose Java Applet from Insert Menu - [Ctr] + [J]

Dialog Box Options:

Applet Type
Specifies whether or not you will use a supplied Applet from Soft Lite, or use one of you own (user-
defined).

Applet Source

Type the name of the Java applet source file. Java applet source files usually have a CLASS filename 
extension, as in “hello.class”.

Applet Base URL

Type the URL of the folder containing the Java applet source file.

Message For Browsers Without Java Support

Use this field to type HTML to display in place of the Java applet. Web browsers that do not support Java 
applets will display this HTML message.

Futher Parameters

Use this section to add parameter names and values for the Java applet. Because Java does not provide 
a mechanism for displaying what the parameters and values are for a given control, consult the 
documentation that comes with the Java applet to learn the correct parameter names and the legal values
for each parameter.

Height and Width

These specify the height and width of the Java applet in use.



Introduction to Java Applets
Java is a platform-independent programming language, which creates applications which can be run on 
any computer with the Java Virtual Machine installed.    Applets are also created in Java, but they can also
be run inside a compatible browser too.    For more information go to http://java.sun.com 

Java applets are mostly used for graphical purposes, such as online advertising, rollover images and 
games.    These applets are stored on a web server, and can be run from a computer connected to the 
Internet.    Applets larger than 10 kilobytes should be avoided, as they can take several minutes to display 
and frustrate users.

There are three Java applets supplied with ScriptWorx 3.0:

Ad-Banner (by Eric Benhamou) This applet allows you to specify images in a certain order.

Rotating Clock This allows you to create a twisting clock to display.

Image Cube This allows you to create a cube, where each side has its own image.



Using Images
Add an Image: Choose “Image” from the Insert Menu - [Ctrl] + [I]

You can either insert an image from a web server, by typing its address (for example, 
http://www.softlite.net/new.gif is valid) or by browsing for any image on your computer.    Simply click the 
Browse button to look for files on your hard disk. (A preview of “nearly” all image types is now available).

You can specify a height and width for the image, by using the up and down buttons next to the height 
and width boxes.    However, this may garble the image and often gives it a ‘rugged’ finish.    The best 
method is to use the images’ original size.

Images for use on a web browser should ideally be:

CompuServe Bitmap (*.gif)
Joint Pictures Expert Group (*.jpg or *.jpeg)

but the following could also be used:

Portable Network Graphic (*.png)

Users must note that .gif files only support 256 colors, but .jpeg images support millions of colors.



Hyperlinks
Using Hyperlinks: Choose “Hyperlink” from the Insert Menu - [Ctrl] + [H]

What Are Hyperlinks?

These are references to other HTML documents, e-mail addresses, news groups and so on.    These 
appear using the <a href="..."> tag in the document.    In between the inverted commas, you insert a 
protocol and an address, eg. http://www.softlite.net

These links appear underlined in a document.

The following can also be used:

Protocol Used to...
https:// Secure Web Page
mailto: Loads Users E-Mail Client
news: Uses a news server
ftp:// Uses an FTP server
gopher:// Uses the gopher protocol
file:// Display a page on your hard disk

For working on the web, it is recommended you use relative links.    These don't need a protocol, and so 
here is an example:

Full Page Address:
http://anysite.anytime.com/directory/filename.htm

Relevant Link:
/directory/filename.htm

Hyperlink Text:
<a href="/directory/filename.htm">Special File</a>

This only works for files in the same directory, so otherwise you will have to include a full link like:

<a href="http://anysite.anytime.com/directory.htm">Special 
File</a>



Introduction to Frames
Adding Frames: Choose “Frameset” from Frames Menu

For non-frames browsers, add <noframes> </noframes> tags with suitable text 
inbetween.

For floating frames, using <iframe src=”filename”> </iframe> (IE Only).

Frames divide a Web browser's window into separate regions, each of which can display a separate, 
scrollable page. A group of frames is called a frames page. A frames page is a special Web page that 
defines the size and location of each frame it contains.

In the simplest frames page there are two frames: one frame displays a page listing a set of hyperlinks, 
and the other frame displays the pages to which the hyperlinks point. Each time a user clicks a hyperlink 
in the first frame, the page pointed to by that hyperlink is displayed in the second frame. The frames page 
itself does not actually contain any content or pages; it contains only hyperlinks to existing pages that are 
displayed in the frames.

The following sets up a double paned window, with a narrow column on the left, and a large pane on the 
right.    SRC is the SouRCe of the document in a frame.    This example uses two pages, pagea.htm and 
pageb.htm to be displayed in their respective frames.

<frameset rows="30%,70%">
    <frame SRC="pagea.htm" NAME="contents">
    <frame SRC="pageb.htm" NAME="article">
    <noframes>

You are not using a frames browser.
    </noframes>
</frameset>



Using Lists
Using Ordered Lists: Choose Ordered Lists from the Lists Menu
Using Unordered Lists: Choose Unordered Lists from the Lists Menu
Adding a List Item: Choose List Item from the Lists Menu

What’s the Difference?

Ordered lists are lists created using automatic numbers (ie. 1,2,3,4...), but unordered lists simply use 
bullets for each list item.

Adding List Items

Between either your <ul> </ul> or <ol> </ol> tags, add a list items as indicated above, and a list will be 
created from each <li> tag found between the list tags.

Other Options

·A menu list presents an unordered list of short entries.

·A definition list presents terms and their definitions. Generally, a term is rendered flush left, and its 
definition is indented.



Opening Files Using HTTP
Downloading and editing is easy!

Soft Lite ScriptWorx now allows you to download HTML files directly into the program, by using the 
industry-standard HTTP protocol.    You can download HTML files and JavaScript source files too.

NOTE: You must have sufficient permission to download files from a server, so if it is a hidden file you are 
trying to download, an error message may be the result of your action.

To open a file from the web, click the “Open” button on the toolbar, and choose the “Open from Web...” 
option from the menu.

In the dialog box that is displayed, type in the name of the page you wish to download, and simply click 
the “OK” button to get the page.    It may take several minutes to download a page due to the variable 
speed of the Internet and your modem in particular.



HTML Code & Preview
The HTML Code tab is the main editing window, and has been enhanced since the last version of 
ScriptWorx.    The editor will accept files of any length, and automatically highlights the following 
types of code:

HTML, JavaScript, VBScript, CSS, Perl, Pascal, ASP and SQL.

The editing window has a ‘gutter’ alongside the code, which contains line numbers and also shows any 
lines that you may have bookmarked.    Bookmarks can be used from the “Editor” tab in the main window.  
Each button activates an image at the current line in the gutter.    To switch a bookmark off, move to the 
line it is on, and simply click the button you used to turn it on.

HTML is automatically validated: blue keywords are correct, red keywords are incorrect or unrecognised.

For help filling out JavaScript functions, simply highlight the first part of the function (eg. document ), 
select it using the mouse and then click the “CodeHelper” button under the “Document” tab.



Importing RTF Files
Importing RTF Files: Choose “Import RTF To HTML” from the Tools Menu

You can import files in Rich Text Format and they will be imported to HTML by ScriptWorx.    This does not
require Microsoft Office or any other word processor to be installed.



Format Style
The “Choose Format Style” button under the “Document” tab allows you to have the editor colored to suit 
the current document being edited, with keywords, variables and functions being highlighted.



Contact Us
Getting Support

In order for you to receive 90 days free technical support via e-mail, you must first register your copy 
using the Soft Lite web site.    Go to http://www.softlite.net/sworx/tech.htm

Technical Support:
scriptworx@softlite.net

Bug Report:
scriptworx.bugreport@softlite.net

Distribution:

scriptworx.distribute@softlite.net

Comments:
scriptworx.comments@softlite.net

Please read the readme.txt and license.txt files included with your copy of ScriptWorx for more 
information.



Revision History
Version 1.00 - 
Basic design only.    No built in tags, etc. and not released into public domain.

Version 1.01 -
Addition of some JavaScript and VBScript Functions Only.

Version 1.02 -
Addition of JavaScript and VBScript Events
Highlighting Editor Added
First Help File Compilation

Version 1.1 -
Full library of JavaScript and VBScript Events & Functions Added
Addition of Template Selector
48 Keywords added to Highlighting Editor

Version 1.2 -
Initial Templates Added, Minor Bug Fixes Applied
Browser Preview Added

Version 1.21 -
36 New Keywords added to Highlighting Editor
Templates Finalised and Integrated into Executable only

Version 1.22 -
Find & Replace Dialog Boxes Added
Insert... Dialog Boxes Added
Support for Cascading Style Sheets Added

Version 1.40a -
Help File Finalised
One File Installation Added
Refresh Problem Fixed
Tags for Editor Finalised

Version 1.40b -
Installation Routine Optimized
Icons added to Template Selector for Ease of Use

Version 1.41 -
New Installation Routine

Version 1.5 -
Help File Updated
Templates modified
Dial-Up Networking Feature added

Version 2.0 - (Featured Software, ZDnet Software Library, June 1999)
Interface Enhanced
Forms Added

Version 2.01
Tables Added



Interface Enhanced
New Templates Added
Bug fix in hyperlink added

Code Keep Added - Keep track of all your code files
Multiple tag highlight colours

Version 2.1
Open from Web.. Feature added to HTML Editor to fetch web pages.
(Note: This feature does not currently retrieve ASP content)

Version 3.0 - This Release
Built-in HTML Preview.
Instant Table: Created tables in three clicks.
Click>Type allows you to click anywhere and type.
User-defined coding lists, with even more HTML & JavaScript tags.
More templates including JavaScript, DHTML, VBScript, Perl and CSS.
Support for CGI/Perl 5 ; Pascal ; SQL ; AWK ; Java.
Cascading Style Sheets Builder ("Style Builder").
Undo / Redo Features.
Better Syntax Highlighting (Automatic colouring of words without spaces).
Now has ASP commands support.
Enhanced editor with line numbers, tracks and breaks.
New installation method (Inst*llShield).
HTML Tag Verifcation: Blue - Correct / Red - Incorrect



Year 2000 Compliance
About this Program

Soft Lite ScriptWorx is Year-2000 compatible, but Soft Lite is not responsible for the user's computer clock
and calendar.    Therefore, any incompatible systems are not the responsibility of Soft Lite, but that of the 
user.    Any damage or loss of data that may ensue are the fault of the user and not of Soft Lite.

This program has been tested with dates in 1999, 2000 and 2001, and roll-over tests have been 
conducted.

User of previous releases: All versions of ScriptWorx are Y2K compliant.    However, we cannot claim 
compatibility on computers which have not been accurately test for Y2K compliance.



Code Lists
These are the “HTML”, “Functions” and “Events” tabs which provide a list of most used commands for 
HTML, JavaScript and VBScript.    To customize these, open the directory you installed ScriptWorx 3.0 
into, and do the following:

1. Look for either libevents.axl or libfunctions.axl or libhtml.axl
2. Open any of these files in a text editor (eg. Notepad)
3. Add or delete any entries
4. Save the file
5. Re-start ScriptWorx, where your new lists will be displayed.



Perl and CGI
Perl is a scripting language like any other, which is a list of commands that the user’s browser will 
execute.    Perl has existed for a much greater period of time the JavaScript and VBScript, and yet most 
people web users pass along unaware of this.    The Unix / Linux community has support Perl for a very 
long time, due to it’s open source nature.    Perl has only recently become popular on Windows NT 
servers, thanks to a 32-bit port of Perl being created.

The greatest use of Perl has been in forms processing, but it does have a variety of other uses:
Search engine submission tools;
Voting and Surveys;
Games;
and Auctions.

Please Note: Not every web page host supports Perl, and it may require you to pay an additional fee.    
Almost all free hosting companies do not support users own Perl scripts, but may provide a selection of 
their own.




